Poglavije 2

Kako vecina ljudi koristi Word

U ovom poglaviju

Zapocinjanje novog dokumenta u Wordu

Saveti za kucanje

Formatiranje

TraZenje pomoci

Snimanje dokumenta na disk

Stampanje

Zatvaranje dokumenta

K ad je reC o upotrebi Worda, vecina korisnika jedva da zagrebe povr-
Sinu onoga §to se u njemu moZe uraditi. Nije ni to loSe, samo hocu
da kaZem da je malo onih koji se udube u ovaj program ili su srecnici
poput vas da imaju knjigu koja im otkriva sve tajne. Ljudi uglavnom kori-
ste Word na ovaj nacin:

Zamislite dva ratnika u punoj svemirskoj opremi, kako ulaze u kabinu
svog fantastiCnog, futuristickog vasionskog broda. Okrenu dugmad, pro-
vere merace i otkucaju Sifre. Kazu nesSto poput: ,,Uklju¢ena mreza kvantne
fuzije!“, i: ,Provereno!, pa: ,Aktivirano antigravitaciono protonsko polje“,
zatim: ,,Prijem“. Tlo pocCinje da se trese, a neverovatna masina vibrira dok
turbine stenju i svetla trep¢u. Najzad se Cuje: ,Krecemo!* Ratnici krenu
punim gasom i masina se uz gromoglasnu buku uzdigne sto metara iznad
zemlje. A onda ratnici sve iskljuce i izadu.

Tako vecina ljudi koristi Word.

Ovo poglavlje vas upucuje u osnovne korake svakodnevnog koriscenja
Worda. U stvari, kada bi ova knjiga bila pamflet, onda bi je ¢inilo ovo
poglavlje. (Ostatak knjige samo nudi viSe detalja i veoma korisnih infor-
macija i opravdava cenu knjige.)
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26 Deo I: Zdravo svete!

Opsti pregled (za nestrpljive)
Proces obrade teksta u Wordu odvija se na sledeci nacin:
1. Zapocnite nov dokument u Wordu.
. Kucajte.
. Formatirajte.
. Snimite.
. Pregledajte pre stampanja.
. Odstampajte.

N S G WN

. Zatvorite.

Svi prate ove korake na neki nacin. Dobar korisnik Worda ponavlja korake
2, 314, ponekad menjajuci njihov redosled. (Vecinu vremena u Wordu
provedete kucajudi. Pri kraju procesa, trebalo bi da pocnete s formati-
ranjem, iako to mnogi rade dok kucaju.)

Ako ste ranije snimili dokument i Zelite ponovo da radite na njemu, prvi
korak zamenite sa: ,,Otvorite dokument s diska“. (O komandi Open bice
viSe reci u poglavlju 8.)

Koraci 5 i 6 preduzimaju se samo kada ste zavrSili obradu teksta i plani-
rate da odStampate svoj rad. (U poglavlju 9 bice reci o opcijama Preview
i Print.)

Ostatak ovog poglavlja detaljno opisuje korake u radu na dokumentu.

Zapocinjanje novog dokumenta

Kada pokrenete Word, on vam nudi prazan dokument, podesan za
kucanje. Sledeci logican korak je da pocnete da kucate.

Ukoliko morate da zapocnete nov dokument a ve¢ radite na neCemu u
Wordu (na primer, piSete pismo prijatelju i u trenutku se setite da ste
zaboravili da otkucate hitno poslovno pismo), uradite sledece:

1. Izaberite File => New.
Na levoj strani ekrana pojavljuje se okno za poslove New document,
s gomilom opcija za pravljenje ovog ili onog novog. Vama treba nov
dokument.

2. Izaberite stavku Blank Document.

Okno za poslove nestaje i pred vama je prazna strana, spremna da je
popunite.
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Poglavlje 2. Kako veéina ljudi koristi Word

E Ovo cete brZe uraditi ako na paleti alatki pritisnete dugme New. Otvara se
prazna strana za pisanje novog dokumenta, a vi ne morate da se petljate s
dosadnim okvirom za poslove i zbunjuju¢im opcijama.

v Tacno je, Word vam omogucava da radite na viSe dokumenata
istovremeno, a sve to je opisano u poglavlju 10.

v Rad moZete da zapocCnete i otvaranjem dokumenta s diska (za viSe
informacija pogledajte poglavlje 8). Kada je dokument otvoren,
pojavljuje se u prozoru bas kao i svaki drugi dokument koji ste
napravili. Odradite posao!

Kucanje (ili lov i kljucanje)

Zaboravite na sve spravice i zanimljive moguénosti! Veéi deo vremena
u Wordu provescete kucajudi.

Klik-klak-klik-Rlak

Samo napred, kucajte; neka vasi prsti lete po tasterima! Ono §to kucate
pojavljuje se na ekranu, slovo za slovom - ¢ak i uvrede na racun racu-
nara. (Vas racunar uopSte ne mari, ali to ne znaci da je Word potpuno
bezosecajan.)

Nov tekst izranja neposredno ispred kursora koji treperi. Na primer,
mozete otkucati ovakav tekst:

Podrigivanje za stolom je prihvatljivo.
Ako hocete da izmenite recenicu, pomerite kursor neposredno ispred
recCi prihvatljivo. Koristite strelicu okrenutu nalevo na tastaturi da biste
kursor pomerili unazad. (Nemojte koristiti taster Backspace.) S kurso-
rom koji trepce tik ispred reci prihvatljivo, otkucajte sledeci tekst:

ne

Dok kucate, novi tekst se ispisuje, a stari se, ukoliko postoji, povlaci ka
desnoj ivici (ili ¢ak u novi red), praveci mesto novajliji.

Nova reCenica sada glasi ovako:

Podrigivanje za stolom je neprihvatljivo.
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28 Deo I: Zdravo svete!

S

v Kad god pritisnete taster nekog znaka, taj znak se pojavljuje na
ekranu. To vaZi za sve tastere sa slovima, brojevima i simbolima.
Drugi tasteri, obicno sivi, ¢ine cuda i divote koje ¢u podrobno
objasniti u nastavku knjige.

v Ako ste nekada koristili pisacu masinu, sigurno ste prevalili Cetr-
desetu! Sto ste matori! Salu na stranu, u programu za obradu teksta
nemojte koristiti slovo I ili malo slovo L za broj jedan, ili slovo O za
nulu. To je pogresno. Otkucajte 1 za broj jedan i 0 za nulu.

v Ne plaSite se da upotrebite tastaturu! Word uvek upozori pre nego
§to napravite ozbiljnu glupost. Korisna funkcija Undo vratice sve
Sto ste greSkom obrisali; o tome cete saznati viSe u poglavlju 4.

v Taster Shift proizvodi velika slova, bas kao i na pisa¢oj masini (ako
ste je ikada koristili).

v Taster Caps Lock radi kao taster Shift Lock na pisa¢oj masini. Posto
ga pritisnete, upali se lampica iznad numericke tastature i sve §to
kucate ispisuje se VELIKIM SLOVIMA.

v Izvinite zbog poredenja s pisa¢om masinom.

v Tasteri s brojevima na desnoj strani tastature ¢ine numericku tasta-
turu. Da biste ih koristili, morate da pritisnete taster Num Lock i
upalice se njegova lampica na tastaturi. Ukoliko to ne ucinite, ovi
tasteri imace funkciju kursorskih tastera ili tastera sa strelicama.

v U nekim kulturama, podrigivanje za stolom potpuno je prihvatljivo,
cak se smatra da je nepristojno ne podrignuti.

Kada treba pritisnuti taster Enter

quEI

Taster Enter pritisnite samo kada dodete do kraja pasusa.
Savetujem vam da procitate ponovo tu reCenicu:

Pritisnite taster Enter samo kad dodete do kraja pasusa!

Da li moram da nauéim da kucam?

Da biste koristili program za obradu teksta, njih. Pretpostavljam da mi se samo dopada
ne morate da znate da kucate, ali ¢ete sebi ime Mavis.

u€initi uslugu ako naucite. Nabavite pro-
gram koji ¢e vas tome nauciti. Preporucujem
program Mavis Beacon Teaches Typing,
iako za ovu reklamu nisam dobio novac od

Ako znate da kucate, bolno iskustvo kao Sto
je rad u Wordu, bice prijatnije.
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Poglavlje 2. Kako veéina ljudi koristi Word

S

Za razliku od kucanja na pisa¢oj masini, program za obradu teksta radi

s reCima i pasusima, ne sa redovima teksta. Zato je vazno da naznacite
programu gde se zavrSava pasus. A red teksta? To nije problem: kad prili-
kom kucanja dodete do ivice margine, program za obradu teksta auto-
matski prelomi tekst u sledeci red. Znaci, taster Enter treba da pritisnete
samo kad dodete do kraja pasusa.

Na primer, otkucajte tekst koji sledi. Samo ga otkucajte i nemojte se
zamarati razmiSljanjem da li treba da pritisnete Enter:

Sedeli smo c¢utke, ali u isc¢ekivanju, dok smo gledali kako
baka pazljivo raspakuje poklon. Obazrivo je odvijala traku
i odmotavala papir, kao $to je uvek ¢inila; odrasla u vreme
velike krize, navikla je da c¢uva sve ukrasne papire da

bi ih kasnije za neSto upotrebila. A kad je ugledala svoj
prvi digitalni fotoaparat preplavilo ju je oduSevljenje.
Zapljeskali smo! Bil ga je ve¢ podesio, pa smo se svi
namestili za poziranje, a baka je podigla fotoaparat do
lica, brzo pritisnula i - snimila svoj nos.

Primecujete li kako se tekst prelama? Poslednje parce teksta na kraju jed-
nog reda pomera se nadole, na pocCetak sledeceg reda. [ sve to automat-

ski! Ne Cuje se zvuk , ding!“ — a nema ni potrebe da pritiskate taster Enter
na kraju svakog reda. Dakle, Enter se pritiska samo na kraju pasusa.

v Ova osobina (prenosenja teksta iz jednog reda u drugi), naziva se
prelamanje teksta (engl. word wrap).

v Neki ljudi pasus zavrSavaju tako Sto dva puta pritisnu taster Enter;
drugi ga pritisnu samo jednom. Ukoliko Zelite da napravite ve¢i pro-
red, koristite posebnu komandu za formatiranje reda koju sam
objasnio u poglavlju 12.

v Dupli prored se takode postiZze posebnom komandom za formati-
ranje teksta. Ne pritiskajte Enter da biste napravili dupli prored!
Procitajte viSe o tome u poglavlju 12.

v Ako hocete da uvucete sledeci pasus, posle tastera Enter pritisnite
Tab.

v Ako pritisnete Enter usred pasusa, Word deli taj pasus u dva nova
pasusa. Tekst iznad kursora postaje jedan pasus, a tekst iza kursora
postaje sledeci pasus.

v Znak Enter moZete izbrisati pomocu tastera Backspace ili Delete.
Uklanjanjem znaka Enter spajate dva pasusa.
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Dosao je red na uslovan prelom reda

Jos jedan nacin da zavrSite pasus — a da ga, u stvari, ne zavrSite — jeste da
upotrebite tastersku kombinaciju Shift+Enter, koja se naziva i uslovan
prelom reda (engl. soft return) ili prekid reda (engl. line break). Na taj
nacin zavrSavate red teksta i zapocinjete nov red koji nije ujedno i pocCe-
tak pasusa. Otkucajte sledeci red:

Sluzenje Hendersonovih

Sada pritisnite Shift+Enter. Kursor se pomera na pocetak novog reda.
Nastavite da kucate:

(Ovo nije kuvar)

Sada pritisnite Enter da biste oznacili kraj pasusa.

Ceo ovaj tekst je jedan pasus, mada se pojavljuje u dva reda. To je sustina
uslovnog preloma reda ili prekida reda. NajviSe se koristi u tabelama, ali

moZe se primeniti i na obrasce, Web stranice ili na dokumente u kojima je
takvo formatiranje neophodno.

v Ne, uslovne prelome reda verovatno necete koristiti u istoj meri kao
prave prelome (koji se, slucajno, zovu bezuslovni prelomi, engl. hard
returns).

v’ Ako vam je bas stalo, pogledajte Sta sve ima o tabelama u poglavlju
20.

Kad treba lupiti po razmaknici

Razmaknicu koristite za umetanje razmaka izmedu reci ili reCenica.
BeznjeteSkodabistemoglidacitatetekst.

U Worduy, kao i u svim programima na racunaru u kojima se nesto kuca,
izmedu recenica se stavlja samo jedan razmak. (Ako ste daktilograf, na
ovo Cete se teSko navici, ali ne odustajte, moguce je.)

Najveci porok mnogih korisnika Worda jeste Sto razmaknicu upotreblja-
vaju za poravnavanje kolona ili uvlacenje redova. Ovo je pogresno, i kada
odstampate dokument videcete da on izgleda neukusno i jeftino. Da, jef-
tino i neukusno.

Umesto razmaknice, za poravnavanje ili uvlacenje teksta koristite taster
Tab. Taster Tab je najbolji nac¢in da organizujete informacije na ekranu.
Zarazliku od razmaknice, taster Tab uvlaci tekst na tacéno mesto, tako da
odStampan dokument bude lep i uredan. (U poglavlju 13 bice viSe reci o
tasteru Tab.)
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Poglavlje 2. Kako veéina ljudi koristi Word

v Razmaknicu koristite za umetanje razmaka izmedu redi ili reCenica.

Ny 2 v Dovoljan je jedan razmak izmedu reCenica. Kad god vam zatreba
y w viSe od jednog razmaka, na primer, da uredite tekst u stupcima ili
da ga slozite, koristite taster Tab (opisan u poglavlju 13).

v Cujem da profesori daktilografije i dalje ue ucenike da izmedu
recenica umecu dva razmaka. Znate Sta? GreSe!

v Rimljani nisu mogli da stavljaju razmake izmedu reci u natpisima
zgrada zato Sto sindikat klesara nije znao kako da ih naplati.

Stvari na koje treba obratiti painju
tokom kucanja

Dok kucate, deSava se mnogo zanimljivih stvari, od kojih ¢e vas neke
zbuniti, druge nervirati, a nekoliko njih ¢e vas nepotrebno uplasiti.

Statusna traka

Prvo §to cete primetiti tokom kucanja jeste statusna traka na dnu ekrana.
Informacije na njoj govore vam nesto o vaSem dokumentu i mestu na
kojem sada kucate. Na slici 2-1 je sve objasSnjeno, mada ja obracam paZnju
samo na stavku Page (strana na kojoj se trenutno radi) i ukupan broj
strana dokumenta (drugi broj stavke C na slici 2-1).

A) Strana koju uredujete

C) Tekuca strana/Ukupan broj strana dokumenta

|
Slika 2-1:

Tajne statusne
trake.

F) Kolona u kojoj se nalazi kursor gledajuci sleva nadesi

| Page 1 Gec 3 14 Ax 1~ am 1 Call |

E) Red na strani u kome se nalazi kursor

D) PolozZaj kursora u odnosu na vrh strane

B) Ignorisite

Praznina izmedu strana

Word voli da pokaZe gde se zavrSava jedna strana i pocCinje druga. To je
korisno, jer se moZe desiti da nesto §to ste napisali zauzme dve strane, a
vi ste mislili da ¢e stati na jednu. U tom slucaju, pogledajte na statusnoj
traci (slika 2-1) koliko ukupno strana ima dokument ili na kojoj se strani
nalazite. Word ima i vizuelne metode da to utvrdite.
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32 Deo I: Zdravo svete!

]
Slika 2-2:
Prelom strane u
prikazu Print
Layout.

Word nudi dva na¢ina pomocu kojih moZete videti gde pocinje nova
strana, u zavisnosti od toga koji prikaz (engl. view) koristite dok radite.

Ako izaberete View = Print Layout (prikaz pre Stampanja), pojavice se
prelom strane (engl. page break). Na slici 2-2 vidite kako to izgleda. Strane
su bele, a prostor izmedu njih je siv.
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Ukoliko izaberete View => Normal, Sto je prikaz koji ja koristim, prelom
strane se pojavljuje kao povorka mrava koji marsiraju preko ekrana. Ne
prskajte ih sredstvom protiv gamadi!

Red mrava predstavlja prelom strane u normalnom prikazu. Tekst koji se
nalazi iznad mrava, tj. tacaka, pripada prethodnoj strani; tekst ispod njih
je na narednoj.

v Prelom strane ne moZzete izbrisati. MoZete pomeriti mesto preloma,
ali ako tekst ne mozZe da stane na stranu, Word automatski smesta
viSak teksta na sledecu stranu.

v’ Red gusto zbijenih tacaka — veoma prijateljski nastrojenih mrava
- oznac¢ava bezuslovan prelom strane (engl. hard page break). Cak se
ireCi Page Break pojavljuju na sredini tackaste linije. O bezuslov-
nom prelomu strane saznacete viSe u poglavlju 14.

Tacke izmedu veci!
Ako na ekranu vidite tacke nakon Sto ste pritisnuli taster Enter ili raz-
maknicu, ne panicCite. Evo kako to izgleda:

Ovoemozeedasbudesiritirajuce.q
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Cest problem na koji nailaze mnogi korisnici ~ sledece: pritisnite Ctrl+End, &ime cete kur-
Worda, jeste kada im program saopsti daje  sor pomeriti na sam kraj dokumenta, na pos-
dokument za jednu stranu duZi nego $to bi lednju stranu. Zatim paZljivo pritiskajte
trebalo, i da je ta poslednja strana prazna. taster Backspace sve dok prazna strana ne
Da biste se oslobodili prazne strane, uradite  nestane. | to je sve!

Oslobodite se poslednje, prazne, strane

Ono Sto vidite na ekranu kada vas tekst izgleda poput prethodnog reda,
jesu znakovi koji se ne Stampaju (engl. nonprinting characters). Word
koristi razli¢ite znakove za ono Sto se obi¢no ne vidi: razmaci, tabulatori
i taster Enter.

Cemu ovo sluzi? Prikazivanjem znakova koji se ne stampaju mozete lako
pronaci greSku u formatiranju dokumenta, Sto biste inace teSko uocili.
Na primer, dva tabulatora mogu da iznenada poremete tekst na kojem
radite. Prikazivanje ovih znakova je jedini nacin da utvrdite da ste priti-
snuli taster Tab dvaput zaredom.

v Da biste iskljucili znakove koji se ne Stampaju, pritisnite kombina-
ciju tastera Ctrl+Shift+8 (ali ne sa numericke tastature). Ako ste
radoznali, pritisnite istu kombinaciju da biste ih ponovo ukljucili.

v Ove znakove moZete da prikaZete ili sakrijete i ako na paleti sa stan-
dardnim alatkama pritisnete dugme Show/Hide.

v Znakovi se prikazuju na ekranu ali, na svu srecu, ne i u Stampanom
dokumentu.

Crveni i zeleni talasici

Podvlacenje teksta u Wordu ide kao od Sale; sve Cete to saznati u poglavlju
11. Ponekad se, ipak, desi da Word sam podvuce reci crvenim, zelenim i
ljubiCastim talasastim i isprekidanim linijama. Na taj nacin vas upozorava
da nesto nije u redu s tekstom.

Greske u pravopisu Word oznacava crvenom talasastom linijom. To znaci
da je ukljuCena frustrirajuca opcija za proveru pravopisa. Word vam kaZe:
»~Hmmm! Nisam ba$ siguran da je ova podvucena rec ispravna!*

Zelena linija oznacava gramaticke greske. Word vam skrece paznju da ste
se ogresili o englesku gramatiku. (Opustite se, pa ko tu ne gresi?)

Isprekidana ljubicCasta linija koristi se u Wordu za pametne oznake (engl.
smart tags). Time se oznacavaju imena osoba pomenutih u tekstu, datumi
i adrese koje biste Zeleli da prenesete u ostale Microsoftove programe iz
paketa Office.
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Ignorisite sve ove linije dok ne predete na uredivanje dokumenta. (Osim
ako postanete opsednuti time, ali tako ¢ete znatno sporije pisati.)

v U poglavlju 7 nadi ¢ete vise informacija o ispravljanju pravopisnih
i gramatickih gresaka u Wordu - i nauciti kako da iskljucite ovu
opciju ako vam ne treba.

v’ U poglavlju 34 procitacete sve Sto treba o pametnim oznakama,
izmedu ostalog, kako da ih iskljucite.

Cuvaj se psa (Office Assistant)!

Dok vi kucate, vas pomo¢nik radi mnoge zanimljive stvari, koje ¢e vam
moZda biti i zabavne. U stvari, ako dugo cCitate ili razmiSljate, primeticete
kako je vas pomocnik zaspao (pogledajte psa na margini). To znaci da bi
trebalo da prestanete da buljite u prazno i bacite se na posao!

JUps! Cini mi se da sam nesto zabrljao!"

Ako pogresite, pritisnite taster Backspace da biste se vratili unazad i
obrisali gresku. Ovaj taster ¢ete prepoznati po reci Backspace koja je
na njemu napisana ili po strelici ulevo: .

Ukoliko pritisnete i drZite taster Backspace, brisacete niz znakova koji
se nalaze levo od kursora, sve dok ne otpustite taster.

Taster Delete takode guta znakove, ali s desne strane kursora.

Za malo vece greSke, Word ima taster Undo. On ne briSe tekst ali vam
pomaze da povratite tekst koji ste sluCajno obrisali. ViSe o opciji Undo
procitajte u poglavlju 4.

Formatiranje dokumenta

Formatiranje omogucava da vas dokument izgleda profesionalno a ne
kao da je izaSao iz neke razglavljene pisace masSine. U dokumentu moZete
da formatirate viSe elemenata:

v znakove

v pasuse

v tabulatore

v Citav dokument
v strane

v stupce (kolone)

v zaglavlja i podnoZja.
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Poglavlje 2: Kako vecina ljudi koristi Word 35

Vasa osnovna duzZnost u obradi teksta jeste da napiSete tekst. Nakon
toga, najcesce Cete se vratiti unazad i formatirati ga, menjajudi stil ili
podesSavajuci margine. Sve ovo je objaSnjeno u drugom delu knjige.

v Word moze da formatira dokument umesto vas. To je opisano u
poglavlju 18.

v Vecina ljudi tekst formatira dok kuca, dodajuci kurziv, polucrna
slova ili bilo Sta drugo. | pasuse mozete da formatirate dok piSete,
iako je najvece zadatke na formatiranju najbolje raditi nakon ispi-
sivanja teksta. (Primeri obe tehnike dati su u drugom delu knjige.)

v Word dozvoljava da tekst formatirate dodajuci crteZe, slike, linije,
tabele, stupce i druge elemente koji ¢ine da dokument izgleda
privlacno. Ove teme su obradene u trecem i petom delu knjige.

Prizivanje pomoci
Da biste dobili pomo¢, pritisnite taster F1. Iza ovog tastera se krije Wor-
dov prozor za pomo¢. UpiSite pitanje ili frazu da biste pronasli odgovor,
ili pritisnite hipervezu Table of Content (sadrZaj) da biste pregledali
Wordov ogroman i konfuzan prirucnik. [zaberite kako ¢ete se mugiti!

MoZete se uputiti i na lokaciju Microsoft.com na Webu i tu potraziti
pomo¢ ili obuku. Ali vi imate ovu knjigu i ona bi trebalo da vam pomogne
u najvecem broju opstih tema; nema razloga da gubite vreme (i novac)
pokuSavajudi da izvucete informacije od Microsofta.

Jo§ jedan nacin da dobijete pomoc jeste da koristite Officeovog pomoc-
nika (ako ga vidite na ekranu). Pritisnite miSem pomoc¢nika i pojavice se
oblaci¢ u kome pise: ,,What would you like to do?“ (,,Sta biste Zeleli da
radite?*) UpiSite pitanje (na engleskom jeziku), kao Sto je pokazano na
slici 2-3. Pritisnite taster Enter i pas ¢e vam odgovoriti:

Av! Vau! Vau! Vaaaaaaaaaaaau!

rulhlt!nﬂld you bke bo do? 1

I want o go 4o Tahiti

|
Slika 2-3:
Officeov
pomocnik je
spreman da
pomogne.
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36 Deo I: Zdravo svete!

Ozbiljno, Officeov pomo¢nik odlazi da potrazZi pomo¢, a rezultati se oCas
posla pojavljuju u prozorcicu. MoZete pritisnuti miSem stavku koju hocete
da procitate i, uz BoZju pomod, pronaci cete Sta vam treba.

Snimajte svoja pisanija!

Racunar je tup. RaCunar je zaboravan. Gubi stvari. Da biste svom racunaru
pomogli da ne zaboravlja, morate mu izricito reci da snimi to Sto ste napi-
sali. Dokument sa ekrana mora biti sacuvan na disku u obliku datoteke.

Da biste dokument snimili na disk, izaberite komandu File &> Save, ili pre-
Cicu Alt+F,S. (1li pritisnite na paleti sa standardnim alatkama dugme Save,
ono sa sliCicom diskete.)

Ako dokument snimate prvi put, pojavljuje se okvir za dijalog Save As,
kao na slici 2-4.

Tt t I3
T T s TRl | ] Tk
Srehie —— [T
£} Farlin 4l 8 g b Dades w:
Hy Pt el o i ¥
S L b o 8 o | 3=
P prommd Thadig g ] 2
u—J o P framd Sl ey Ao W] s
. =t ks Somroes i s W] e
P s s e | ™
i Pt i LR 4 ™
J ik B s et i i]cn
My Doraranin ™ s 'Lt o ey miem b | P
Lmr B P minsr b e wrkes papelond e B 5oy
& hamy i R L aE
I i3 [ LT pr—— v
Slikaz-4; | © T i = ’
Okvir za dijalog = 1 R = o
Save As. i Li:l
Lo R T Frer——m—— =] [
—

U polje File name upiSite ime dokumenta. Na slici 2-4 vidi se da je ime
dokumenta Forest. Ako prilikom kucanja pogresite, upotrebite taster
Backspace da biste se vratili i obrisali gresku.

Da biste snimili dokument, pritisnite dugme Save.

v Snimanje dokumenata je detaljnije objasnjeno u poglavlju 8.

v Datoteku cete kasnije, kada budete hteli da je menjate ili Stampate,
prepoznati po imenu. Vazno je da smislite dobro, opisno ime za
datoteku.
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Poglavlje 2. Kako veéina ljudi koristi Word

S

Q&“JH

UPQ%

v KoriScenje tastature je najbrzi nacin da snimite datoteku. Komandi
Save odgovara kombinacija tastera Ctrl+S. DrZite pritisnut taster
Ctrl (Control), i istovremeno pritisnite taster S. Ako ste od onih koji
mogu da podignu koSarkasku loptu jednom rukom, moZete koristiti
i kombinaciju Shift+F12.

v Posmatrajte statusnu traku dok snimate dokument; na njoj se
povremeno pojavljuje poruka da Word snima dokument (ili da brzo
snima, za one koji koriste tu mogucnost).

v Word (ili Officeov pomo¢nik) obavestice vas ako ste upisali zabra-
njeno ime. Pritisnite OK i pokuSajte ponovo.

v Posto je dokument snimljen na disk, videcete njegovo ime na naslov-
noj traci prozora, i to ¢e biti znak da je dokument sacuvan.

v Ukoliko ste rasejani, moZe se dogoditi da dokumentu date ime koje
vec nosi neka datoteka na disku. Tako c¢ete napraviti sustu glupost,
jer se novija datoteka snima preko starije sa istim imenom. Na pri-
mer, ako odlucite da novo pismo sacuvate pod nazivom PISMO, a
istoimena datoteka vec¢ postoji na disku, sadrzaj novog pisma bice
upisan preko starog. Ne postoji nacin da vratite prvobitan tekst!
Zato smislite drugo, pametnije ime. Upozorenje stize u vidu poruke:

The file 7ime_datoteke already exists.

Pritisnite Cancel ili izaberite opciju da datoteku snimite pod drugim
imenom. Poc¢nite iz pocetka.

Stavljanje na papir (Stampanje)

Najpre

Veliki pisci nisu morali da brinu o §tampanju. Sekspir nikada nije morao
da snimi svoj dokument ili da ga pregleda pre Stampanja. Edgar Alan Po
je napisao Gavrana na papiru, tako da je piSuci zapravo i ,Stampao“. A
Mark Tven, koji je napisao Avanture Toma Sojera na tek nastaloj pisacoj
masini, mislio je da je bas high tech. Sta je s vama?

Stampanje je krajnji rezultat vaseg napornog rada na obradi teksta.
Herkul? E, on je morao da osvoji pojas devojke. Vi? Vi morate da odStam-

pate dokument. Na papiru sve izgleda fino i uredno — skoro profesionalno.

pregledajte ono sto Zelite da stampate

Da biste videli kako ¢e dokument izgledati a da pri tom ne potrosite sav
dragoceni papir, upotrebite komandu Print Preview (prikaz pre Stam-
panja). [zaberite File & Print Preview ili na paleti alatki pritisnite dugme
Print Preview.
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38 Deo I: Zdravo svete!

Na slici 2-5 prikazano je kako izgleda reZim rada Print Preview. Dokument
je prikazan bas onako kako ce izgledati kada bude odStampan, ukljucu-
juci sve slike, zaglavlja i podnoZja ili ostale stavke koje pri uredivanju tek-
sta mozda nece izgledati onako kako treba.

] Rzl Previes] Wil Ward =t
[P [ ‘Naw jpusi Pyoasd Jesie Tihis Seics |k

EHE T s BT Lib

' Bk '_-l i 2 -

I -
Slika 2-5: '
ReZim rada -
Print Preview. | @ = = 1« ®
F'.= h- I. wa ur [T Ea -'_I- )

Dobro. Izgleda dobro. Pritisnite dugme Close da biste se vratili u doku-
= ment radi uredivanja ili Stampanja.

Ureme je za Stampanje
Da biste odStampali dokument u Wordu — dokument koji vidite na
ekranu, i to u celosti — postupite ovako:

1. Proverite da li je Stampac ukljucen i spreman za Stampanje.
Ukoliko su vam potrebna dodatna uputstva o pripremanju Stam-
paca, procitajte poglavlje 9.

2. Izaberite naredbu File > Print.
Otvara se okvir za dijalog Print. On sluzi za kontrolu Stampanja
i svega Sto je u vezi s njim.

3. Pritisnite dugme OK.
Dokument izlazi iz Stampaca.
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Poglavlje 2: Kako vecina ljudi koristi Word 39

v Okvir za dijalog Print moZete otvoriti i pritiskanjem tastera Alt+F,P
ili Ctrl+P. Ova metoda je pogodna ako imate duge prste, bavite se
heklanjem ili vam je misS opet klisnuo da smaze parce sira.

v’ Ne zaboravite da snimite dokument pre Stampanja. To nije pravilo,
ali ja sam izricit kada je re€ o snimanju, snimanju i snimanju doku-
menta.

Zatvaranje dokumenta

Da biste zatvorili dokument kada zavrSite rad na njemu, izaberite naredbu
File => Close (Ctrl+W). Ovaj postupak zatvara prozor dokumenta i uklanja
ga sa ekrana. Zzzipp! (Ovo ,zip!“ morate sami da izgovorite; Word je u
ovom slucaju potpuno nem.) O tome je bilo reci i u poslednjem odeljku
prvog poglavlja.

v Zasto treba da zatvorite dokument? Zato Sto ste zavrsili rad na
njemu! MoZda Zelite da radite na nekom drugom dokumentu ili da
izadete iz Worda poSto zatvorite ovaj dokument. Izbor je vas.

v’ Ako pokuSate da zatvorite dokument pre nego §to ste ga snimili,
Word prikazuje okvir za dijalog sa upozorenjem. Pritisnite dugme
Yes da biste snimili dokument. Ukoliko hocete da nastavite sa ure-
divanjem dokumenta, pritisnite dugme Cancel i vratite se na posao.

v Ako radite samo na jednom dokumentu i zatvorite ga, Word izgleda
kao da je napustio prebivaliSte; palete alatki i trake s menijima
nestaju, klizna traka, kao i ostale stvarcice iz prozora. Ne panicite:
upravo ste zatvorili dokument i Word nema Sta da radi. Zato se
§¢udurio i strpljivo ¢eka sledec¢u komandu.

v’ Ukoliko nemate viSe Sta da radite u Wordu, zatvorite ga. U suprot-
nom, moZete da zapoCnete rad na nekom drugom dokumentu. Pogle-
dajte odeljak ,,Zapocinjanje novog dokumenta“, na pocetku ovog
poglavlja.

003N, May 6, 2004 9:22 am






